Flow Chart for Document Preparation Section

1. Get Proposal Data
   (Plan Review and Proposal Development Section)

2. Review Office Copy
   (Plan Review and Proposal Development Section)

3. Correct & Run

4. Revisions and Revision Replacement

5. Bid letting And Checking in Bids

6. Advertisement & Review
   (Other sections)

7. Create an Office Copy

8. Sent to Duplicating

9. Letter Awards

10. Tab & Allocations

11. Contract Award Letters

12. Award Recommendation Letters

13. Execution Letters

14. Contractors Begin Work
Document Preparation Section
Guidelines

Flow Chart of Contract Process.......................... 2
Office Copies ................................................... 3
Card & Folders .................................................. 3
Copy Notes Program ........................................... 5
Office Copy MS Word .......................................... 6
Microsoft Word .................................................. 8
Copying ............................................................. 10
Proposal ............................................................. 11
Awarded Contracts ............................................ 12
Generating Contracts ......................................... 12
Preparing to copy ............................................... 12
Allocation sheet ............................................... 14
Award ............................................................... 14
Rejected ............................................................ 14
ACKNOWLEDGEMENT OF REVISION .............. 15
Revision Replacement .......................................... 16
MBE Clearance form table ................................. 17
MBE CLEARANCE FORM ................................. 18
CONTRACT AWARD SLIP ................................. 18
MATERIALS ENGINEER .................................... 20
Construction Company ....................................... 22
Bonding Company ............................................. 24
District Contract Administrator ............................ 26
Resident Engineer ............................................. 28
Execution letters .............................................. 30
EXECUTION OF CONTRACT .............................. 31
Contract award letters ....................................... 32
CONTRACT AWARD .......................................... 33
CONTRACT PERFORMANCE BOND ................. 34
CONTRACT PAYMENT BOND ............................ 35
CERTIFICATE OF INSURANCE ......................... 36
Award Recommendation Letters ....................... 37
AWARD RECOMMENDATION ....................... 38
AWARD RECOMMENDATION page 2 ................. 39
Revisions .......................................................... 41
Flow Chart for Document Preparation Section

Get Proposal Data  
(Plan Review and Proposal Development Section)

Review Office Copy  
(Plan Review and Proposal Development Section)

Correct & Run

Sent to Duplicating

Revisions and Revision Replacement

Advertisement & Review  
(Other sections)

Bid letting And Checking in Bids

Tab & Allocations

Contract Award Letters

Award Recommendation Letters

Awards

Execution Letters

Contractors Begin Work
Office Copies
Card & Folders
Card - See sample of card below

<table>
<thead>
<tr>
<th>RTE:</th>
<th>ORDER NO.:</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROJ.:</td>
<td>FHWA:</td>
</tr>
<tr>
<td>LENGTH:</td>
<td>TYPE:</td>
</tr>
<tr>
<td>DES.:</td>
<td></td>
</tr>
<tr>
<td>COUNTY:</td>
<td>PROPOSAL MADE BY:</td>
</tr>
<tr>
<td>APPROVED BY FHWA:</td>
<td>CHECKED BY:</td>
</tr>
<tr>
<td>ADV. FOR BIDS:</td>
<td>DATE:</td>
</tr>
</tbody>
</table>

RTE: - The Route number goes here
ORDER NO.: - the Order number goes here
PROJ.: - the project number goes here
FHWA: - the FHWA (Federal High Way Administration) number goes here
LENGTH: - the listed length goes here, note might be listed as: FROM
TYPE: - listed under the length or FROM line, note might be listed as: TO
DES.: - the description goes here
COUNTY: - the listed county goes here
PROPOSAL MADE BY: - find the Engineer name and it goes here

Labels
Both labels will have the following in this order on them to look like this:

ORDER NO.: L##
PROJECT NO.: ####.-####,L####
COUNTY: LLLLLLLLLL

This is an example so you have to replace the ‘#’ with the correct number and the ‘L’ with the correct letter.

Folders
A fix one label to each of the two folders and on one also paper clip the card to it. The one that only has a label will be the master copy folder. The other will be the office copy folder.
On the office copy folder on the front flap under the label write the MEG (Marvin Graham), your initials, ADV-, ADV-
This will end up looking like this:

<table>
<thead>
<tr>
<th>MEG</th>
</tr>
</thead>
<tbody>
<tr>
<td>LLL</td>
</tr>
<tr>
<td>ADV-</td>
</tr>
<tr>
<td>ADV-</td>
</tr>
</tbody>
</table>
Copy Notes Program
Open program (USA flag Icon with CNSP)
First click on the Merge button

- Merge the following points must be noted on this screen:
  1. JDN/Order # - enter correct order number here as the last order number will still be kept in this location from previous contract
  2. Contract ID # - as above for contract ID #
  3. Route # - as above for Route #
  4. FHWA # 1 - State contracts will have ‘NONE’ entered. Federal contracts will have numbers entered.
  5. Project # 1 - these are the lines that the project number will be put in. NOTE put them in exactly as they are on the contract, with every period comma, EXACTLY as it is in the contract.
  6. County - county name goes here
  7. District - district name goes here
  8. Description # 1 - EXACT description goes in these lines. It is best to break it up as they are printed on the contract as well because these lines can only hold a maximum of 40 character.
  9. From - this is where the from line goes. NOTE if there is only one location you can enter LOCATION: the list the location this will make editing in Microsoft Word easier later on
  10. To - this is the To line
  11. Let Date - this is the date the contract will be bid on
  12. MBE% - get this from the MBE #
  13. WBE% - get this from the DBE #
  14. Sheets - this is the page number of the last price sheet
  15. Time Limit - how many days they have to complete the project.
  16. Type of Contract - click for either state or federal contracts. Note federal jobs have FHWA numbers, and state contracts will have ‘NONE’ in the FHWA line above
  17. Buttons - next click the ‘Update’ button and then the ‘Merge’ button, you will be asked, ‘You are about to create a (State or Federal) contract. Are you sure you wish to continue?’ click ‘yes’. Last click ‘Close’

- Copy - click the ‘Copy’ Button. Once that screen is up select the copy note provisions and add them. NOTE C### are English measurements and CM### are metric measurement. After adding all the necessary copy note click ‘Save’ then click ‘Quit’

- Special - click the ‘Special’ button. Once that screen is up select the copy note provisions and add them. NOTE F### and S### are English measurements and FM### and SM### are metric measurement. After adding all the necessary copy note click ‘Save’ then click ‘Quit’

- IMPORTANT! Microsoft Word must be shut down before you go any further in this process.

- Build - click the ‘Build’ button. Click the check boxes to get the data from the ‘Merge Screen’ the ‘Copied Notes’ and the ‘Special Provisions’ then click start. You will get the message, ‘We will now start Word and finish building this contract!’ click ‘OK’
Office Copy MS Word

Use the Index on page 2 to go to Copy Note for ‘LABOR’ check the Information sheet to see which VEC office this job is to use and consult the Chart to match the number. (Chart is next page.)

If contract is a Metric Job use the Metric Water Mark. (Shown below.)

_____________________________________________________________________________________________
<table>
<thead>
<tr>
<th></th>
<th>Address</th>
<th></th>
<th>Address</th>
<th></th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5520 Cherokee Ave, Alexandria, VA, 22312-2319 (703) 813-1300</td>
<td>15</td>
<td>P. O. Box 7106 Fredericksburg, VA 22404-7106 (540) 898-3806</td>
<td>29</td>
<td>206 Third Avenue Radford, VA 24141 (540) 831-5980</td>
</tr>
<tr>
<td>2</td>
<td>Post Office Box 16129 Bristol, VA 24209-6129 (540) 642-7350</td>
<td></td>
<td>P. O. Box 1398 Galax, VA 24333-1398 (540) 236-5105</td>
<td></td>
<td>3751 Nine Mile Road Suite A Richmond, VA, 23223 (804) 236-3500</td>
</tr>
<tr>
<td>3</td>
<td>P.O. Box 191 Buena Vista, VA 24416-0191 (540) 261-2188</td>
<td>16</td>
<td>1320 LaSalle Avenue Hampton, VA 23669 -3810 (757) 727-4888</td>
<td>30</td>
<td>S P.O. Box 13327 Richmond, VA 23225-5756 (804) 674-2368</td>
</tr>
<tr>
<td>4</td>
<td>P.O. Box 1850 Cedar Bluff, VA 24609-9803 (540) 964-4007</td>
<td></td>
<td>P. O. Box 351 Harrisonburg, VA 22801-0351 (540) 434-2513</td>
<td></td>
<td>W P.O. Box 6871 Richmond, VA 23230-2905 (804) 662-9614</td>
</tr>
<tr>
<td>5</td>
<td>P.O. Box 1587 Charlottesville, VA 22902-1587 (434) 984-7630</td>
<td></td>
<td>P.O. Box 10849 Lynchburg, VA 24506-0849 (434) 947-6671</td>
<td>33</td>
<td>P. O. Box 40008 Roanoke, VA 24022 (540) 561-7525</td>
</tr>
<tr>
<td>6</td>
<td>504 Cedar Road Chesapeake, VA, 23320 (757) 547-9717</td>
<td></td>
<td>Not listed</td>
<td></td>
<td>P. O. Box 483 South Boston, VA 24592-0483 (434) 572-8674</td>
</tr>
<tr>
<td>7</td>
<td>P.O. Box 918 Covington, VA 24426-0918 (540) 962-0983</td>
<td>20</td>
<td>Not listed</td>
<td>34</td>
<td>P. O. Box 4306 Martinsville, VA 24115-4306 (540) 632-3270</td>
</tr>
<tr>
<td>8</td>
<td>P.O. Box 969 Culpeper, VA 22701-0969 (540) 829-7430</td>
<td></td>
<td>P. O. Box 969 Culpeper, VA 22701-0969 (540) 829-7430</td>
<td>35</td>
<td>P. O. Box 9530 Virginia Beach, VA 23450-9530 (757) 431-4978</td>
</tr>
<tr>
<td>9</td>
<td>P.O. Box 6800 Danville, VA 24540-6800 (434) 791-5291</td>
<td>21</td>
<td>P.O. Box 1650 Marion, VA 24354-1650 (540) 781-7431</td>
<td>37</td>
<td>P. O. Box 1650 Suffolk, VA 23434-1650 (757) 925-2376</td>
</tr>
<tr>
<td>10</td>
<td>1746 East Atlantic Street Emporia, VA 23847 (434) 634-2326</td>
<td>22</td>
<td>P.O. Box 4306 Martinsville, VA 24115-4306 (540) 632-3270</td>
<td>38</td>
<td>P. O. Box 9530 Virginia Beach, VA 23450-9530 (757) 431-4978</td>
</tr>
<tr>
<td>11</td>
<td>P.O. Box 545 Exmore, VA 23350 (757) 442-6176</td>
<td>23</td>
<td>P.O. Box 660 Norton, VA 24273 (540) 679-9413</td>
<td>39</td>
<td>P. O. Box 67 Warsaw, VA 22572 -0067 (804) 333-3675</td>
</tr>
<tr>
<td>12</td>
<td>13135 Lee Jackson Highway Suite 340 Fairfax, VA 22033-1907 (703) 803-0000</td>
<td>24</td>
<td>5145 East Virginia Beach Blvd Norfolk, VA 23502 (757) 455-3960</td>
<td>40</td>
<td>Williamsburg Crossing Shopping Center 5235 John Tyler Highway Williamsburg, VA 23185 (757) 253-4738</td>
</tr>
<tr>
<td>13</td>
<td>P.O. Box 392 Farmville 23901-0392 (434) 392-8871</td>
<td>25</td>
<td>P.O. Box 660 Norton, VA 24273 (540) 679-9413</td>
<td>41</td>
<td>100 Premier Place Winchester, VA 22602 (540) 722-3415</td>
</tr>
<tr>
<td>14</td>
<td>P.O. Box 240 Fishersville, VA 22939-0240 (540) 332-7750</td>
<td>26</td>
<td>Not listed</td>
<td>42</td>
<td>P. O. Box 673 Wytheville, VA 24382 –0673 (540) 228-4051</td>
</tr>
</tbody>
</table>
Microsoft Word
Opening
- Building - Once CNSP has opened Microsoft Word click the ‘Start Button’ and word will open all the pieces of the contract. You will get several pop up boxes, click ‘YES’ or ‘OK’ to all of them.

- Once Word says that the contract is complete open - Dropdown box > File > Finalout.doc

- Check all data on the Form C-6a against the Merge Data sheet. Scroll to last page of the document and ensure that the headers and page numbers have gone on every page of the document.

- Opening - dropdown box > File > Save As F:\COPY\WORK\PROPOSAL\ document name is the Order #.

Insertions
- Attach Documents - Some of the attachments will be in an electronic form that can be inserted directly into the documents. To insert these go to Opening - dropdown box > Insert > File F:\ > Copy Special copier notes will be listed as yL## and special provisions will be listed as zL## where the ‘L##’ is the Order number of the contract. If this is not on the computer and is not attached write ‘forth coming’ on the Office Copy Folder. Save document.

- 303h - add the price listed by the special provision. When adding the price remember to underline the price after adding it

- 518 - add the price listed by the special provision. When adding the price remember to underline the price after adding it

- Wage rate sheet - insert from F:\WAGE RATES if there is a wage rate to be inserted. Merge Data form will list a wage rate on it.

- Labor section of copied note: VEC (VA Employment Commission) Office - the merge data sheet will have a VEC Office number listed reference the Virginia Employment Commission Office sheet and add that correct numbered office. Insert > AutoText > AutoText then pick office and click Insert Save document.

- Metric symbol - NOTE this only needs to be done on Metric contracts. Contracts that use English measurements do not need the metric watermark added to them. Form C-6a - Opening - Dropdown box > View > Header and Footer go to the bottom of the page, click in the right side of the footer, Opening - dropdown box > Insert > Text Box click in the footer to place the text box. Left click on the grey outline of the textbox to get the properties of it. Go to format text box. Make sure you are in the ‘Colors and Lines’ tab. For the fill color click the drop down button and select ‘No Fill’. For the line color click the drop down button and select ‘No Line’. Opening - dropdown box > File > Open F:\ > 1-(METRIC)SELECT USE PROV > Metric Watermarkm click on one of the watermarks and copy it, then paste it into the text box in the contract document. Go to
last page to ensure that the watermark was entered into every footer in the document. Save document.

- Wage rates - Insert the listed wage rate on the Merge Data sheet. Opening - dropdown box > Insert > File F:\ > WAGE RATES selected the wage rate and click ‘Insert’. Save document. Write in ‘Wage Rate Tracking Sheet’ the Bid Date, Order #, Project #, and the Wage Rate. Look in the inserted wage rate to get the ‘Dec #’ and the ‘Dec. Date’. These are the Decision Number and Decision Date.

Editing
- Deleting - remove extra blank lines between the copy notes. Also, do this in the Special Provisions section. Do not remove the page breaks between the different sections of special provisions.

- Page Breaks - put in page breaks to keep paragraphs and tables and charts all on the same page. Note in copy notes the end of a sections looks like this: ##-##-## (SPCN)

- Measurements - only one of the measurement paragraphs is needed so find out if it is the English or the metric one and delete the other. They look like this:

  This Contract shall be constructed in accordance with: the Virginia Department of Transportation Road and Bridge Specifications, dated January 1994; and Road and Bridge Standards, dated February 1, 2001; the Virginia Work Area Protection Manual, dated January 1, 1996; and Special Provisions and Special Provision Copied Notes as listed herein.

  This Contract shall be constructed in accordance with: the Virginia Department of Transportation Metric Road and Bridge Specifications, dated January 1997; and the 1996 Road and Bridge Standards, the Virginia Work Area Protection Manual, dated January 1, 1996; and Special Provisions and Special Provision Copied Notes as listed herein.

Index
- Updating - the index do not forget to add any lines for things that are attached but not in electronic form thus can’t be inserted into the document.

- Updating - do not forget to update the entire index before saving and printing

Saving - save often and completely after every major change. Save before printing
Copying
Copy attached pages and put them into the back of the Master Copy folder in the correct places, that is make sure that B section is in front of C section.

Copy all of the following pages on 3 holed paper and put them in this order in the Office copy folder:

- C-61/C-111 & C-112
- C16a
- C-53
- C-7
- Price sheets
- Index
- Copy Notes
- Any Special Copy Notes
- Predetermined Minimum Wage Rates
- Decision of Secretary
- Special Note 303h
- Special Note 518
- Attached Sections
- Blue back cover

Filing in folders ensure that price sheet are in Master copy behind the C-7.
Proposal

1. Cards
   Get card and type on it in the following places
   A. RTE.: put the Rte number for the data sheet here
   B. Order NO.: place order number here from data sheet
   C. Proj.: put the project number from the price sheets here
   D. Length: get this from the ‘From’ line on the data sheet
   E. Type: get this from the ‘To’ line on the data sheet
   F. Des.: get this from the description on the data sheet
   G. County: get this from the county on the datasheet
   H. Proposal Made By: find the name of the engineer on the data sheet and place it here

2. Labels & Folders
Type the following on the labels:
Order No.: place order number here from data sheet
Project No.: put the project number from the price sheets here
County: get this from the county on the datasheet

3. Master copy
Awarded Contracts
Generating Contracts

Collecting
• Get new price sheets (in folder on shelf over the large copier)

• Get letter folder (on same shelf over copier)

• Get Office copy folder

• Master Copy - from the file cabinet on the back wall.

Preparing to copy
• Order of forms - a list of all forms to pull out of the clipped bid in the office copy folder and the order to put them in. Once in this order copy them.
  1. c-61/c-111&c-112
  2. c-7
  3. price sheets
  4. contract performance bond (c-18a)
  5. contract payment bond
  6. power of attorney
  7. certificate of insurance
  8. c-43
  9. c-42
  10. c-45
  11. c-73

• master copy - remove and put aside all between the index and the first copy note. Put copied section from above into the contract in front of the index and behind the c-6a

• print order form - fill out this and place it on the front of the adjusted master copy then give the contract to someone to have it checked. All three lines need to be filled out. Job designation is the order number. Date is the date that this will go to the 13th floor to be copied. Date of finished product required is two working days after the date sent up to be copied. Once checked take up to 13th floor for duplication.

• Office copy - should have these things in this order when it is to be checked.
  1. colored cover
  2. bid summary
  3. index c-118
  4. c-24
  5. first copy of power of attorney (this one is usually stapled to a c-24)
  6. conditional withdraw
  7. c-104
  8. c-105
  9. MBE/DBE coversheet
  10. most other non copied stuff that was in it before a section was put together
  12. c-61/c-111&c-112
  13. c-7
14. price sheets typed then the written
15. contract performance bond (c-18a)
16. contract payment bond
17. power of attorney
18. certificate of liability
19. c-43
20. c-42
21. c-45
22. c-73

Finishing Copied Master
• Receiving duplicates
  1. Get the copies from the 13th floor.
  2. office copy - pull all before the index off and hole punch it and put this behind the reordered office copy
  3. for blue covered contracts stamp 6 copies with the “I CERTIFY THAT THIS IS A TRUE AND CORRECT COPY” stamp and the office copy with the “EXECUTED” stamp.
  4. for yellow covered contracts stamp 7 copies with the “I CERTIFY THAT THIS IS A TRUE AND CORRECT COPY” stamp and the office copy with the “EXECUTED” stamp.
  5. check the letters folder to see how many extra you will need to send out with this, note this will be on the half sheet paper clipped to the left side of the inside of the folder
  6. have these stamped copies and the office copy checked. Send the date worksheet with these.
Allocation sheet
Award
Top right, white out anything after the ‘/’ in the FHWA number.
Top left, white out the ‘PROJECT NO.’ in front of the (PCN)

Top to the left of the Net total of regular bid Type: PROJECT NO. & the project number obtained from the C-7.

Bottom, RECOMMENDED FOR: AWARD

Approved for: AWARD

In front of BY COMMONWEALTH type AWARDED

Under RECOMMENDED FOR get the city and state of the Company listed and type under it aligned with the company name. Note this information can be obtained from the C-7 also.

The only other thing to do is to make any changes indicated on the ‘pencil’ copy.

Rejected
Rejections get the following note in REMARKS:
IT IS FELT THAT BETTER BIDS WOULD BE ATTAINED BY THE RE-ADVERTISEMENT OF THIS PROJECT.

RECOMMENDED FOR will say: REJECTION

The only other thing to do is to make any changes indicated on the ‘pencil’ copy.
ACKNOWLEDGEMENT OF REVISION

Acknowledgement shall be made of receipt of any and all revisions and/or addenda pertaining to the above designated project which are issued by the Department through the Contract Engineer's Office prior to the bid opening date shown herein. Failure to include this acknowledgement in the bidding proposal may result in the rejection of your bid.

By signing this bid, the Bidder acknowledges receipt of the following revisions and/or addenda to the proposal and/or plans for the above designated project which were issued under cover letter(s) of the date(s) shown hereon:

1. Cover letter of __________________________ (Date)
2. Cover letter of __________________________ (Date)
3. Cover letter of __________________________ (Date)

_________________________________________  _______________________
SIGNATURE                                      DATE
Revision Replacement
### RAAPs or SAAPs

MBE Clearance form table
Date if Bids Letting

<table>
<thead>
<tr>
<th>JOB DES.:</th>
<th>BOND</th>
<th>DBE/MBE (✓ COLUMN)</th>
<th>CLEARED</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>C-61</td>
<td>C-111A</td>
</tr>
</tbody>
</table>

|          |      |                     |         |            |
|          |      |                     |         |            |
|          |      |                     |         |            |
|          |      |                     |         |            |
|          |      |                     |         |            |
|          |      |                     |         |            |
|          |      |                     |         |            |
|          |      |                     |         |            |
|          |      |                     |         |            |
|          |      |                     |         |            |

17
RAAPs or SAAPs

MBE CLEARANCE FORM

I Jason Roman-Nolen HEREBY RELEASE ALL MBE CLEARANCE OF THE FOLLOWING

PROJECTS TO CATHY SIMPSON:

BIDS RECEIVED: «Bid_Date»

ORDER NO.: C-61/C-111 Not Needed if ? Clearance Date

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________
CONTRACT AWARD SLIP

BIDS RECEIVED.: AUGUST 7, 2003

ORDER NO.: E49

PROJECT NO.: RW-E49-03

CONTRACT INFORMATION: JDRN

AWARDED BY ____________________ DATE _______

SENT TO DUPLICATING _________ DATE _______

RETURNED FROM DUPLICATING DATE _______

CHECKED BY ____________________ DATE _______

MAILED BY ______________________ DATE _______

GIVEN TO PATSY ________________ DATE _______

RECEIVED BY KAREN ____________ DATE _______
DEPARTMENT OF TRANSPORTATION
DEPARTMENTAL MEMORANDUM
RICHMOND, VIRGINIA

January 20, 2004

TO: MR. ANDREW J. MERGENMEIER
    MATERIALS ENGINEER

ORDER NO.: E49
ROUTE: 616
PROJECT NO.: RW-E49-03
Wise COUNTY

FROM: DON E. SILIES

SUBJECT: ATTACHED PROPOSALS

The attached on the above project are for your files.

DON E. SILIES
CONTRACT ENGINEER
TO: MR. ANDREW J. MERGENMEIER  
MATERIALS ENGINEER  

ORDER NO.: E49  
ROUTE: 616  
PROJECT NO.: RW-E49-03  
Wise COUNTY  

FROM: DON E. SILIES  

SUBJECT: ATTACHED PROPOSALS  

The attached on the above project are for your files.  

DON E. SILIES  
CONTRACT ENGINEER
January 20, 2004

ROUTE: 616
PROJECT NO.: RW-E49-03
Wise County

Estes Bros. Const., Inc
Rt. 3, Box 740
Jonesville, VA 24263

Gentlemen:

We are enclosing for your files ONE CERTIFIED contract on the above Construction project.

Yours very truly,

Don E. Silies
Contract Engineer
January 20, 2004

ROUTE: 616
PROJECT NO.: RW-E49-03
Wise County

Estes Bros. Const., Inc
Rt. 3, Box 740
Jonesville, VA 24263

Gentlemen:

We are enclosing for your files ONE CERTIFIED contract on the above Construction project.

Yours very truly,

Don E. Silies
Contract Engineer
January 20, 2004

ROUTE: 616
PROJECT: RW-E49-03
Wise County

Gentlemen:

We are enclosing for your files ONE CERTIFIED contract on the above Construction project.

Sincerely,

Don E. Silies
Contract Engineer
January 20, 2004

ROUTE: 616
PROJECT: RW-E49-03
Wise County

Gentlemen:

We are enclosing for your files ONE CERTIFIED contract on the above Construction project.

Sincerely,

Don E. Silies
Contract Engineer
January 20, 2004

ROUTE: 616
PROJECT NO.: RW-E49-03
Wise County

District Contract Administrator
Bristol District

Gentlemen:

We are enclosing for your files ONE CERTIFIED contract on the above Construction project.

Sincerely,

Don E Silies
Contract Engineer
January 20, 2004

ROUTE: 616
PROJECT NO.: RW-E49-03
Wise County

District Contract Administrator
Bristol District

Gentlemen:

We are enclosing for your files ONE CERTIFIED contract on the above Construction project.

Sincerely,

Don E. Silies
Contract Engineer
January 20, 2004

ROUTE:  616  
PROJECT NO.: RW-E49-03  
Wise County

Resident Engineer  
Wise

Gentlemen:

We are enclosing for your files ONE CERTIFIED contract on the above Construction project.

Sincerely,

Don E. Silles  
Contract Engineer
January 20, 2004

ROUTE: 616
PROJECT NO.: RW-E49-03
Wise County

Resident Engineer
Wise

Gentlemen:

We are enclosing for your files ONE CERTIFIED contract on the above Construction project.

Sincerely,

Don E. Silies
Contract Engineer
Execution letters
Still working on this as the process ahs changed so the numbers are at this time unknown.
EXECUTION OF CONTRACT
RTE.: 623
PROJ.: 0623-070-6902, SR01
FHWA: NONE
PATRICK COUNTY

LANFORD BROTHERS COMPANY, INC
PO BOX 7330
ROANOKE, VA 24019

Gentlemen:

This is to advise that the Department has executed the Contract for the above project. The execution date is ________________.

MR. FRED ALTIZER, District Administrator, SALEM, Virginia will be in charge of this work and you will be responsible for the details pertaining to the construction of this project, through the District office. By copy of this letter, the District Administrator is advised that the Contract has been fully executed and a "Notice to Proceed" for the work may be issued.

The Resident Engineer will notify your firm of the date, place & time of the Pre-Construction Conference. No Physical work should be performed before the conference, unless approved by the Engineer.

Plans have been furnished to you previously, (when applicable), and a copy of the executed Contract will be sent to you under separate cover. Please review the Contract document thoroughly and notify the Department of any discrepancies within (10) ten days. If we do not hear from you within the specified time the contract will stand as executed.

Sincerely,

Don E. Silies
Contract Engineer
DES/jdrn
District Administrator - SALEM
Resident Engineer - MARTINSVILLE
District Contract Administrator - SALEM
Contract award letters
13 collated copies distributed as follows:

1. original to be kept
2. wayne Varga
3. highlight attached (3)
4. contractor
5. copy to central file
6. Mergenmeir
7. Mohammed
8. Department of taxation
9. DMV
10. F. W. Dodge
January 20, 2004

CONTRACT AWARD
RTE.: VARIOUS
PROJ.: PRMO-965-101,N508
FHWA: NONE
COUNTY: ACCOMACK & NORTHAMPTON
ORDER NO.: V75

TRAFFIC LINES, INC
5100 ASHBURY ROAD
FARMINGDALE, NJ 07727

Gentlemen:

The Virginia Department of Transportation on August 14, 2003, has approved the award of a contract for construction of the above project, based on your bid of $172,973.50 submitted on July 22, 2003. When specified in the contract, the award is conditional pending receipt of required Disadvantage Business Enterprise information. The execution of this contract is subject to any necessary concurrence of the Federal Highway Administration and other pertinent authorized agencies, if applicable.

You will be advised of final execution of the contract by the Department.

Sincerely,

Don E. Silies
Contract Engineer

Copies to File
Andy Mergenmeir - Materials Engineer
Mohammed Mirshahi - Location & Design Engineer
District Administrator - HAMPTON ROADS
Resident Engineer - DISTRICT OFFICE
District Contract Administrator - HAMPTON ROADS
Department of Taxation
F.W.Dodge Corp.
Order No.: «OrderNo»

COMMONWEALTH OF VIRGINIA
DEPARTMENT OF TRANSPORTATION

CONTRACT PERFORMANCE BOND

Know all men by these presents. That we

Hereinafter called the (“principal”) and

(hereinafter called the “Surety”), are held and firmly

bound unto the Commonwealth of Virginia (hereinafter called the “Owner”), in full and just sum of

Dollars ( $_______________ ) lawful money of the United States of America to be paid to said

“Owner.” Its successors, and assigns, to which payment well and truly to be made we bind ourselves, executors,

administrators, successors, and assigns jointly and severally and firmly by these presents:

Whereas, The above bounden: “Principal” has entered into a contract with the said “Owner” by and through

the Commonwealth Transportation Commissioner of the Department of Transportation, said contract being attached

hereto, for constructing or otherwise improving

Project: «Project»
From: «FROM»
To: «TO»

upon certain terms and conditions in said contract more particularly mentioned: and

Whereas. It was one of the conditions of the award of the “Owner” pursuant to which said contract was

entered into, that these presents shall be executed:

Now: Therefore. The conditions of this obligation is such that if the above burden “Principal” shall in all

respects comply with the terms and conditions of said contract and his obligations thereunder, including the

“Specifications”; with amendments thereto, “Special Provisions,” “Proposal,” and plans therein refered to and made a

part thereof, and such alterations as may be made in said plans and specifications as therein provided for, and shall

indemnify and save harmless the said “Owner” against or from all cost, expenses, damages, injury or as loss to which

the said “Owner” may be subjected by reason of any wrongdoing, misconduct, want of care or skill, negligence or

default, including patent infringements, delay or failure to comply with contract provisions, on the part of said

“Principal,” his agents or employees, in the execution or performance of said contract, including errors in the plans

furnished by the “Principal,” and shall pay all just claims for damages and injury to property then this obligation to be

void; otherwise, to be and remain in full force and virtue in law.

Witness, The signature of the “Principal” and the signature of the “Surety” by its Attorney-in-fact and its

corporate seal duly attached by their Attorney-in-fact,

hereunto affixed this _______________ day of _______________ in the year ____________

(Principal) (Surety Company)

By: By:

(Officer, Partner or Owner) (SEAL) Attorney-in-fact (SEAL)

(Address) (Address)

(Continued)
ORDER NO.: «OrderNo»

CONTRACT PAYMENT BOND

Know all men by these presents. That we

Hereinafter called the “Principal” and

(hereinafter called the “Surety”), are held and firmly bound unto the Commonwealth of Virginia (hereinafter called the “Surety”), are held and firmly bound unto the Commonwealth of Virginia (hereinafter called the “Owner”), in full and the just sum of

Dollars ( $ ________________ ) lawful money of the United States of America to be paid to said “Owner.” Its successors, and assigns, to which payment well and truly to be made we bind ourselves, executors, administrators, successors, and assigns jointly and severally and firmly by these presents:

Whereas, The above bounden “Principal” has entered into a contract with the said “Owner” by and through the Commonwealth Transportation Commissioner of the Department of Transportation, said contract being attached hereto, for constructing or otherwise improving

Project: «Project»
From: «FROM»
To: «TO»

upon certain terms and conditions in said contract more particularly mentioned: and

Whereas, It was one of the conditions of the award of the “Owner” pursuant to which said contract was entered into, that these presents shall be executed:

Now: Therefore. The conditions of this obligation is such that if the above burden “Principal” shall promptly pay all just claims for labor and material (including public utility services and reasonable rental of equipment when such equipment is actually used at the site) performed for or supplied to said “Principal” or any subcontractor in the prosecution of the work contracted for then this obligation is to be void; otherwise; to be and remain in full force and virtue in law.

Witness, the signature of the “Principal” and the signature of the “Surety” by its Attorney-in-fact and its corporate seal duly attached by their Attorney-in-fact,

hereunto affixed this ____________ day of ________________ in the year ________________

(Principal) (Surety Company)

By: ___________________________ By: ___________________________
(Officer, Partner or Owner) (SEAL) Attorney-in-fact (SEAL)

(Address) (Address)
ORDER NO.: «OrderNo»

COMMONWEALTH OF VIRGINIA
VIRGINIA DEPARTMENT OF TRANSPORTATION

CERTIFICATE OF INSURANCE

This form must be completed and returned with in 15 days of notification of contract award to:
Don E. Silles, Contract Engineer
Virginia Department of Transportation
1401 E. Broad Street, Richmond, VA 23219

This is to Certify that the ________________________________ Insurance Company

Assured ________________________________ Company

Address

<table>
<thead>
<tr>
<th>Street</th>
<th>City/County</th>
<th>State</th>
<th>Zip Code</th>
</tr>
</thead>
</table>

Policies of Insurance Described as Follows:

<table>
<thead>
<tr>
<th>Kind of Policy</th>
<th>Workmen's Compensation</th>
<th>Bodily Injury Liability and Property Damage Liability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy Number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Effective Dates</td>
<td>From:</td>
<td>From:</td>
</tr>
<tr>
<td></td>
<td>To:</td>
<td>To:</td>
</tr>
<tr>
<td>Limits of Compensation</td>
<td>Provided by Workmen's Compensation Laws of Commonwealth of Virginia</td>
<td>Each Person: $ ___________</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Aggregate: $ ___________</td>
</tr>
</tbody>
</table>

Exact Location Covered

Classification of Work Covered (detail)

This Certificate is issued at the request of the Virginia Department of Transportation, 1401 E. Broad Street, Richmond, Va. 23219, to whom we will give written notice of cancellation, renewal or expiration of the above policy or policies.

Dated at: 

City/County __________________ State __________________

Agency ____________________________

on the _______ of _____________ Year _____________

By: ________________________________

Authorized Representative
Award Recommendation Letters

6 copies of the letter only
Original set is sent to contractor
Keep a copy of letter for work files for a time of one year.
One copy goes to central file
A copy to CS Alexander
Highlight the names in the attached section and then them through the mail box to them.
AUGUST 14, 2001

AWARD RECOMMENDATION

RTE.: «Route»
PROJ: «Project»
FHWA: «FHWA»
County: «County»
ORDER NO.: «OrderNo»

«CompanyName»
«StreetAddress»
«CityStateZip»

Gentlemen:

Your firm has been determined low bidder on the captioned project with a bid of $«BidAmount» and it will be recommended for award. Therefore, you should immediately make arrangements to provide the Department with the necessary executed Certificate of Insurance (Form C-73, attached) and, Bonds (Forms C-18A, attached) by «DueDate». (Optional) Please complete Form C-45 attached and return with your bonds and insurance. Also sign the attached Form C-7.

Registration with eVa is required prior to award. Please visit WWW.EVA.STATE.VA.US. To enroll.

You are hereby also reminded to submit information in order to satisfy DBE/WBE (MBE) participation in accordance with appropriate Special Provisions, by 4:45 p.m. on the date shown below.

MBE information on Form C-61 by «C61»

DBE information on Form C-111
and applicable C-112(s) by «C111C112»

The above forms are available at the various District and Residency offices located in your area, or on the Construction Division Website (www.virginiadot.org/business/const).
Note: Copies or facsimiles of these forms will not be acceptable.

Please be aware that you are required to submit your Plan of Operations in accordance with Contract requirements. The schedule must be prepared and sent to the Resident Engineer for review and approval. The Resident Engineer shall also be notified of the names of the plants and producers from which materials are to be supplied on a Department furnished source of material form C-25, also available on the website.

After formal action by the Commonwealth, you will be advised accordingly.

Sincerely,

Don E. Silies  
Contract Engineer

Attachments
cc: jdrn  
District Administrator - «District»  
Resident Engineer - «Residency»  
District Contract Administrator - «DISTRICT»
PROPOSAL OF THE
COMMONWEALTH OF VIRGINIA
DEPARTMENT OF TRANSPORTATION

SUBMITTED: 10:00 AM, TUESDAY, JULY 22, 2003

PROJECT NUMBER: 0001-089-X24, N501; 0206-048-X08, N501; 0206-048-X09, N501
ROUTE NUMBER: 1 & 206
FHWA NUMBER: NONE
DESCRIPTION: TRENCH WIDENING
LOCATION: VARIOUS LOCATIONS
DISTRICT: FREDERICKSBURG COUNTY: STAFFORD & KING GEORGE

I/we declare that no other person, firm or corporation is interested in this proposal; that I/we have carefully examined the plans, job specifications, current road and bridge specifications, and all other documents pertaining thereto and thoroughly understand the contents thereof; that I/we meet the prequalification of this proposal; that I/we understand that the plans and current road and bridge specifications, as defined in the current road and bridge specifications, are a part of this proposal; that all of the quantities shown herewith are a part of this proposal; that all the quantities shown herewith are approximate only; that I/we have examined the location of the proposed work and source of supply of materials; and that I/we agree to bind myself/ourselves upon award of the Commonwealth Transportation Board under this proposal to a contract with necessary surety bond to start work on the date specified in the notice to proceed, and to complete all work in accordance with the plans, job specifications and current road and bridge specifications within the time limit set forth in the contract.

NOVEMBER 3, 2003

BID TOTAL $ 147,912.60

Attached is a bond conforming to the requirements of the current road and bridge specifications, it being understood that such bond is to be forfeited as liquidated damages if, upon acceptance of this proposal, I/we fail to execute the contract and furnish bond as provided in the current road and bridge specifications.

APAC-ATLANTIC, INC
(Names of Individual(S), Firm(S) Or Corporation)

PO BOX 4140 MANASSAS, VA 20108
Street Address City State Zip Code Vendor#/Fin#

By: __________________________ Signature/Title __________________________

(Names of Individual(S), Firm(S) Or Corporation)

Street Address City State Zip Code Vendor#/Fin#

By: __________________________ Signature/Title __________________________

In consideration of the commitments made as shown herein, the Commonwealth of Virginia by The Commonwealth Transportation Commissioner agrees to pay for all items of work performed and materials furnished at the unit price(s) and under the conditions set forth in this proposal, in witnessed by the affixing of the name below.

DEPARTMENT ACCEPTANCE DATE __________________________ By __________________________

CHIEF ENGINEER OF OPERATIONS
VIRGINIA DEPARTMENT OF TRANSPORTATION
Revisions

1. Make all necessary changes with the minimum of alterations.
2. Put copied notes ad added special provisions at the end since they can not be added without changing the placement of things on the index.
3. Update the index. The same start and end copied note or special provisions should be in the same place.
4. Print all changed pages
5. Get copy of the sent out bid to ensure Cathy gets the front and back of what ever sheet she needs.
6. Fill out the acknowledgement of revision
7. Rubber band the whole things to the office copy and take to Cathy.
Plan review and contract development section flow chart

Plans to Construction, first submissions (Set Order number) → Confirm funding
Obtain Project Charge
Begin Project Tracking records

Review
- Compare Estimate to plans
- Notes to plan
- Items match the plan
- Sequence of construction
- Confirm permits
- Check Project file for correspondence
- Run RUMS report
- Check file for Asbestos
- Designate Fuel & Price Adjustment Items
- Obtain Rail Road Agreement
- Discuss with District EEO & determine the number of Trainees
- Set Time limit with District

Select specifications
Get Special provision copy notes written as needed

Feedback to Designers regarding bid-ability review

Build proposal
PS&E to FHWA
(By document production group)

Review final product. Review changed items and quantities to update estimate (done at each change)

Order plans and proposals
Schedule Project Showing
Maintain Project tracking records
Obtain Right of Way Utility Release
Prepare Advertisement Sheet

Second submission review (if needed)
Plan review and contract development section flow chart (Continued)

Advertise Projects

Research to answer contractor questions during advertisement period

Assist with reading bids

Make revisions (as needed)

Attend Statewide Advertisement meeting
Prepare & distribute monthly advertisement schedule

Monitor preparedness for contract
- DBE Approval
- Right of Way Certificate
- City/State Agreement
- FHWA Concurrence
- VPDES Permit Acknowledgement
- Bonds
- Insurance

Prepare Contract for Chief Engineer’s Execution